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PowerMill is the leading NC CAM software specialising in the 
manufacture of complex shapes typically found in the toolmaking, 
automotive, and aerospace industries. PowerMill 2017 offers all of 
the original features of PowerMill 2016, but with numerous 
improvements. This document describes the most significant 
improvements. 

PowerMill 2017 contains the following new features and 
enhancements: 

2D Machining (see page 5) 

 Separating features and holes (see page 6) — Create, edit and 
organise features more easily using the new Feature Groups 
entity. 

 Feature Editor mode-toolbar (see page 7) — Create and edit 
features using the new Feature Editor mode-toolbar. 

 Interactive feature detection (see page 9) — Automatically create 
features from a model using the new Interactive Feature Detection 
dialog. 

 Open region editor (see page 11) — Define open regions of a 
pocket feature using the new Open Region Editor mode-toolbar. 

 Feature hierarchy (see page 13) — Analyse the parent-child 
relationships of nested features in a feature group using the new 
2D Feature Hierarchy dialog. 

 Enhancements to features (see page 15) — Improvements to 
creating and editing features in addition to new turning and face 
features. 

 Enhancements to 2D machining strategies (see page 26) — New 
strategies for machining improved 2D features. 

Summary of new features 
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Turning (see page 90) 

 Turning view (see page 90) — Set the view mode to determine 
how the part is orientated by the standard views. 

 Turning workplanes (see page 91) — Create a turning workplane 
where the Z axis is the rotational axis of the part. 

 Turning curves (see page 92) — Extract a spun profile curve from 
a model using the new Spun profile dialog. 

 Turning features (see page 96) — Create turning features from 
curves for turning toolpaths. 

 Turning tools (see page 98) — Create or import turning tools. 

 Turning toolpaths (see page 102) — Create turning toolpaths 
using the new turning strategies. 

 Turning simulation (see page 104) — Simulate turning toolpaths 
to check for collisions. 

Generating toolpaths (see page 106) 

 Automatic tool axis limits (see page 107) — You can automatically 
calculate the tool axis limits for a toolpath, using the machine 
tool information. 

 Toolpath connections (see page 108) — You can quickly and 
easily define toolpath connections, rapid move clearances, and 
tool safe areas using the new Toolpath connections dialog. 

 Area clearance offset changes (see page 121) — There are 
modifications to Offset all and Offset model area-clearance 
strategies that reduce the number of small moves required to 
remove upstands. 

 Rib machining enhancements (see page 121) — You can now 
generate rib machining toolpaths that cut down the centreline of 
a rib and along its walls. 

 External thread milling (see page 122) — There is a new Feature 
external thread milling strategy. You can now create toolpaths 
with multiple start points. 

 Finishing strategies enhancements (see page 123) — There are 
small enhancements to the 3D Offset Finishing and Steep and 
Shallow Finishing strategies. 

Simulating toolpaths (see page 125) 

 Simulation pausing (see page 126) — You can now control how 
often and on what types of issues simulation stops. 

 Simulation playback (see page 128) — There are new controls on 
the Simulation toolbar. 
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 Simulation toolbar — The Simulation issues  button is now on 

the Simulation toolbar. There is a new Collision checking  
button on the Simulation toolbar. Toggle this button to turn 
collision checking on or off. 

General enhancements (see page 129) 

 ViewCube (see page 129) — Use the new ViewCube to 
interactively orientate the contents of the graphics window. 

 Live text creation (see page 131) — You can now create text as 
wireframe, for engraving or leaving comments in a project. 

 Autodesk A360 (see page 134) — The Tools options includes an 
Autodesk A360 option. 

 Watertight stock models — You can now export watertight stock 
models as .stl or .dmt files. 

 Save strategy parameters — The parameters you can individually 
select to save with a strategy are updated to reflect the toolpath 
connection changes. 
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PowerMill has new branding and is now supplied under the Autodesk 
licensing system. Details of the license are available in the About 
dialog. 

To open the dialog, select the Help > About menu option. 

 

PowerMill rebrand 
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There are enhancements to a number of areas in PowerMill related 
to the 2D machining workflow and user interface. The focus of these 
changes is to enable you to intuitively create, edit, and machine 
features using 2D machining strategies. 

The following changes support these improvements: 

 Separating features and holes (see page 6) — Create, edit and 
organise features more easily using the new Feature Groups 
entity. 

 Feature Editor mode-toolbar (see page 7) — Create and edit 
features using the new Feature Editor mode-toolbar. 

 Interactive feature detection (see page 9) — Automatically create 
features from a model using the new Interactive Feature Detection 
dialog. 

 Open region editor (see page 11) — Define open regions of a 
pocket feature using the new Open Region Editor mode-toolbar. 

 Feature hierarchy (see page 13) — Analyse the parent-child 
relationships of nested features in a feature group using the new 
2D Feature Hierarchy dialog. 

 Enhancements to features (see page 15) — Improvements to 
creating and editing features in addition to new turning and face 
features. 

 Enhancements to 2D machining strategies (see page 26) — New 
strategies for machining improved 2D features. 

2D Machining 
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Separating features and holes 
To support the 2D machining improvements in PowerMill 2017, 
features and holes are separated out of Feature Sets into their own 
entities. This enables you to easily create, edit and organise 
features on a model. 

The explorer includes two new branches, Hole Feature Sets and 
Feature Groups. 

 
Use the new Feature Groups branch to create and edit features using 
the new Feature Editor mode-toolbar (see page 7). 

Use the Hole Feature Sets branch to create and edit holes. The 
workflow of this branch is identical to the old Feature Sets. 
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Feature editing mode-toolbar 
Display the Feature Editor mode-toolbar by selecting Feature Editor 
from the Feature Groups context menu. 

 
Use the options to create or edit features: 

Tolerance — Enter a value to specify the positional tolerance for 
features with respect to each other. This affects how features are 
ordered in the hierarchy. For example, if you want to create a boss 
feature within a pocket feature, having a high tolerance requires the 
boss' lower face to lie on or very close to the pockets lower face to 
be recognised as the pockets child feature. A low tolerance value 
enables the boss feature to be recognised as a child if it is slightly 
misplaced. 

 Snap — Click to toggle between snapping using the intelligent 
cursor or disabling snapping. 

 shows snapping is disabled. 

 shows snapping is enabled. 

The CTRL key temporarily disables snapping. 

 Select all — Click to select all features. 

 Select toggle — Click to deselect the selected features and select 
the deselected features. 

 Select invalid — Click to select all the invalid features in the 
model. 

 Detect features — Click to display the Interactive Feature Detection 
dialog (see page 9). 

 Create rectangular pocket — Click to create a rectangular pocket 
feature. 

 Create circular pocket — Click to create a circular pocket feature. 

 Create freeform pocket — Click to create a freeform pocket 
feature from a curve. 

 Create rectangular boss — Click to create a rectangular boss 
feature. 

 Create circular boss — Click to create a circular boss feature. 
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 Create freeform boss — Click to create a freeform boss feature 
from a curve. 

 Create slot — Click to create a slot feature from a curve. 

 Create unbounded face — Click to create an unbounded face 
feature. 

 Create bounded face — Click to create a bounded face feature 
from a curve. 

 Create turning profile — Click to create a turning profile feature 
from a curve. 

 Create freeform groove — Click to create a freeform groove 
feature from a curve. 

 Create parametric groove — Click to create a parametric groove 
feature. 

 Create turning face — Click to create a turning face feature. 

 Create bore — Click create a bore feature from a curve. 

 Colour — Click to edit the colour of a selected feature. 

 Edit feature — Click to edit a selected feature (see page 21). 

 Feature hierarchy — Click to display the 2D Feature Hierarchy 
dialog. (see page 13) 

 Edit profile curve — Click to edit the profile curve of a selected 
feature using the Curve Editor mode-toolbar. 

 Edit open regions — Click to edit the open regions of a selected 
pocket using the Open Region Editor mode-toolbar (see page 11). 

 Delete — Click to delete a selected feature. 

 Undo — Click to undo your changes. 

 Redo — Click to reinstate the changes you have undone. 

 Calculator — Click to display the Calculator/Measure dialog from 
within the Feature Editor mode-toolbar. 

 Accept — Click to accept and keep all the created features. This 
closes the Feature Editor mode-toolbar and enables normal PowerMill 
functionality. 
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 Cancel — Click to delete all the created features. This closes the 
Feature Editor mode-toolbar and enables normal PowerMill 
functionality. 

 

Interactive feature detection 
You can now easily detect and create features based on model 
geometry using the new Detect Features dialog. This is useful if you 
want to scan a model to detect all features with similar geometry 
and then create those features. 

To detect and create features based on model geometry: 

1 Right-click Feature Groups from the explorer and select Feature 
Editor from the Feature Groups menu. 

The Feature Editor mode-toolbar is displayed. 

2 Click  from the Feature Editor mode-toolbar. 

The Interactive Feature Detection dialog is displayed. 

 
3 Select an option from the Mode list to specify how features are 

selected: 

 Single — Click a feature to select it. 

 Hierarchy — Click a feature to select it and any other features 
inside of it. 

 Similar — Click a feature to select it and any other features 
with similar geometry. 
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4 Hover your cursor over the model to detect the features. The 
feature boundary is highlighted. 

 
5 Click to select the detected features. Click the feature again if 

you want to deselect it. 

 
6 Click Accept to create the features and close the dialog. 

 
The created features are added to a feature group in the 
explorer. 
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Open region editor 
Use the new Open Region Editor mode-toolbar to define open 
regions on pocket features in a model. 

 

 Create open region — Click to create an open region on a pocket 
feature. 

 Delete open regions — Click to delete open regions on all selected 
pocket features. 

 Invert open regions — Click to invert open regions on all selected 
pocket features. 

 Undo — Click to undo your changes. 

 Redo — Click to reinstate the changes you have undone. 

 Accept — Click to accept and keep all the created open regions. 
This closes the Open Region Editor mode-toolbar and returns to the 
Feature Editor mode-toolbar. 

 Cancel — Click to delete all the created open regions. This closes 
the Open Region Editor mode-toolbar and returns to the Feature 
Editor mode-toolbar. 

  

To define an open region on a pocket feature: 

1 Click  on the Feature Editor mode-toolbar. 

The Open Region Editor mode-toolbar is displayed. 

2 Click  on the Open Region Editor mode-toolbar. 

3 Select a pocket feature. 
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4 Click on the model to specify a start  and end point . 

 
The open region is drawn and represented by a dashed line: 

 
5 Drag the handles to redefine the start and end points if 

necessary. 

6 Click  to accept the changes and create the open region. 
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Feature hierarchy 
You can now generate a hierarchy of all the features within a 
feature group that describes the parent-child relationships of the 
contained features. This enables you to quickly identify issues that 
prevent a feature group from being machined. 

Use the 2D Feature Hierarchy dialog to view the hierarchy, select 
features, select parent and child features, and check features for 
machining validity. 

Click  on the Feature Editor mode-toolbar to display the 2D 
Feature Hierarchy dialog: 

 
Feature Group — Displays the active feature group. 

Hierarchy Status — Displays the update status of the feature 
hierarchy. This lets you know if the list is still being recalculated 
after making changes to your features. This is useful if you have a 
large number of features as the list can take some time to update. 
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 — Displays all the feature clusters at the specified Z value. The Z 
value of the cluster is calculated from the parent feature, the 
bottom curve for bosses and the top curve for pockets. The position 
of the clusters along the Z-axis is defined with respect to the 
feature group workplane. The example below shows two feature 
clusters at a Z height of 0 and one feature cluster at a Z height of -
5. 

 

 — Displays the feature clusters and the features included within 
them. A cluster contains features that are related to one another by 
their profile curves intersecting. In this example there are three 
clusters: 

   
A rectangular boss 
within rectangular 
pocket. 

A circular pocket 
within a circular 
boss. 

A rectangular 
pocket. 

The flags adjacent to the clusters and features describe their 
validity: 

  Valid. All geometry is logical for machining. 

  Valid but contains invalid features in the tree. 

  Invalid. Contains illogical geometry. 

 — Displays the feature group's validity for machining. If all 
clusters are valid then Valid for basic machining is displayed. Feature 
area clearance strategies require all 2D features to be aligned at the 
same Z height. If all the clusters are at the same Z height then 
Clusters are Z aligned is displayed. 
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Right-click a feature or a cluster in the 2D Feature Hierarchy dialog to 
display its context menu. Use the options in the context menus to 
select features: 

Cluster context menu Feature context menu 

 

 

 
 

Enhancements to features 
There are changes and improvements to the creation and 
modification of features: 

 Creating features (see page 15) — You can now directly insert 
rectangular and circular features, in addition to creating freeform 
features from curves. 

 Editing features (see page 21) — You can now graphically edit the 
properties of a feature. 

 Face features (see page 24) — There are new milling face 
features. 

 

Creating features 
You can now easily create features and modify their parameters 
using the new Create Feature dialog. Click a feature creation button 
on the Feature Editor mode-toolbar to display the Create Feature 
dialog. 

  Create rectangular pocket 

  Create circular pocket 

  Create freeform pocket 

  Create rectangular boss 

  Create circular boss 

  Create freeform boss 

  Create slot 
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  Create unbounded face 

  Create bounded face 

The Create Features dialog is displayed, depending on the feature 
type. 

 

 The name of the dialog and the options it contains vary 
slightly depending on the type of feature. 

Use the options on each tab to modify the parameters of your 
feature: 

Dimensions — Use this tab to specify: 

 The measurements of the feature. 

 The position of the feature curve. 

 The position of the feature in the workspace. 

 Single creation or multiple creation mode. 

 Whether draft edges are offset with sharp or round corners. 

Corners — Use this tab to specify: 

 The internal corner radii of the feature. 

 This functionality is only available for rectangular pockets 
and freeform pockets or bosses. 
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 The external corner radii of the feature. 

 This functionality is only available for rectangular bosses 
and freeform pockets or bosses. 

Fillets — Use this tab to specify: 

 The top fillet radius, chamfer or sharp edge. 

 The bottom fillet radius or sharp edge. 

 Whether fillets and chamfers are offset with sharp or round 
corners. 

 This functionality is only available for pockets, bosses, and 
slots. 

Origin — Use this tab to specify: 

 The location of the feature with respect to its origin. 

 The position of the feature with respect to the workspace. 

 The orientation of the feature in the XY plane. 
 

Creating a rectangular pocket feature example 
To create a rectangular pocket feature: 

1 In the Explorer, right-click Feature Groups and select Feature 
Editor. 

A feature group is created and the Feature Editor mode-toolbar is 
displayed. 

2 Click  Create rectangular pocket on the Feature Editor mode-
toolbar. 
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The Create Rectangular Pocket Feature dialog is displayed. 

 
3 Click in the graphics window to insert the feature. 

 

 This functionality is only available for rectangular, circular, 
and unbounded face features. For freeform, slot and 
bounded face features you must select an existing curve to 
create the feature from. 

4 Enter a Name for the feature. 

5 Use the options on the dialog or use the graphic handles to 
modify the properties of the feature. 

 The options and graphics handles available vary depending 
on the type of feature being created. 
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6 Click Accept to create the feature and close the dialog. 

7 Click Accept changes  on the Feature Editor mode-toolbar to 
save the created feature. 

 

Creating a freeform pocket feature example 
To create a freeform pocket feature: 

1 In the Explorer, right-click Feature Groups and select Feature 
Editor. 

A feature group is created and the Feature Editor mode-toolbar is 
displayed. 

2 Click  Create freeform pocket on the Feature Editor mode-
toolbar. 

The Create Freeform Pocket Features dialog is displayed. 

 
3 Select a curve in the graphics window to create the feature from. 
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4 Enter a Name for the feature. 

5 Use the options on the dialog or use the graphic handles to 
modify the properties of the feature. 

 The options and graphics handles available vary depending 
on the type of feature being created. 

6 Click Accept to create the feature and close the dialog. 

 

7 Click Accept changes  on the Feature Editor mode-toolbar to 
save the created feature. 
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Creating multiple features example 
Select an option from the Creation mode flyout on the Create 
Features dialog to simultaneously create multiple features: 

 Multiple creation — Creates a single feature at every key-point of 
each selected curve. 

 

 Curve creation — Detects circular or quadrilateral curves and 
creates an appropriate feature for each selected curve. 

 

 These options are only available for rectangular or circular 
pockets and bosses. 

 

Editing features 
You can now easily edit features using the new Edit Features dialog 
or the new graphic handles. 

To edit a feature: 

1 In the Explorer, right-click Feature Groups and select Feature 
Editor. 

A feature group is created and the Feature Editor mode-toolbar is 
displayed. 

2 Select the feature you want to edit and click . Alternatively 
you can double click the feature. 
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The Edit Features dialog is displayed, depending on the feature 
type. 

3 For example, selecting a rectangular pocket displays the Edit 
Rectangular Pocket Features dialog. 

 
4 Use the options on the dialog or use the graphic handles to 

modify the properties of the feature. 

 

 — Click and drag the green spheres to edit the corner radii of 
the feature. 
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 — Click and drag the blue spheres to edit the length of the 
feature. 

 — Click and drag the blue arrows to edit the top face position 
of the feature. 

 — Click and drag the grey bar to edit the profile curve position 
in the Z axis. 

 — Click and drag the red spheres to edit the draft angle of the 
feature. 

 — Click and drag the blue arrows to edit the bottom face 
position of the feature. 

— Click and drag the orange spheres to edit the position of the 
feature. 

 The options and graphics handles available vary depending 
on the type of feature being created. 

5 Click Close to accept the changes and close the dialog. 

6 Click Accept changes  on the Feature Editor mode-toolbar to 
save the edited feature. 
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Face features 
You can now create 2D face features. Faces are simple features that 
define a 2D plane to be machined. There are two types of face 
features: 

Bounded 

An area defined by a closed curve. All material above and within 
this area is machined. 

The image below displays two bounded face features at different 
heights on the model. 

 
To create a bounded face feature: 

1 Click Create bounded face  on the Feature Editor mode-toolbar. 

The Create Bounded Face Features dialog is displayed. 

2 Select a curve on the model. If no curve exists click  Edit 
profile curve to display the Curve Editor mode-toolbar and create 
a curve. 

3 Click Accept to create the feature and close the dialog. 

4 Click Accept changes  on the Feature Editor toolbar to save the 
created feature. 
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Unbounded 

All material above this area is machined. The size of the feature is 
limited by the size of the block. 

 
If the unbounded face feature does not intersect with the block it 
is represented in the graphics window as follows: 

  
To create an unbounded face feature: 

1 Click Create unbounded face  on the Feature Editor mode-
toolbar. 

The Create Unbounded Face Features dialog is displayed. 

2 Click on the model in the graphics window. 

3 Click and drag the graphic handles to adjust the height of the 
feature. 

4 Click Accept to create the feature and close the dialog. 

5 Click Accept changes  on the Feature Editor toolbar to save the 
created feature. 
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2D feature machining strategies 
There are new strategies you can use to make 2D feature machining 
toolpaths. 

 
Use the new Feature Machining page of the Strategy Selector dialog 
to select a feature machining strategy. 

 
 Feature Area Clearance (see page 28) lets you choose between 

raster and offset styles to remove material from a feature. 

 Feature Chamfer Milling (see page 32) bevels sharp corners on 
features using specific chamfer tools. 

 Feature External Thread Milling (see page 40) creates an external 
thread on a boss feature. 

 Feature Face Milling (see page 48) clears flat surfaces specified by 
bounded or unbounded face features. 

 Feature Pocket Area Clearance (see page 53) lets you choose 
between raster and offset styles to remove material from pocket 
features. You can machine multiple pockets at different Z heights 
using one strategy. 
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 Feature Pocket Profile (see page 57) machines around the profiles 
of the pocket features. 

 Feature Pocket Rest Area Clearance (see page 61) adds rest 
machining options to the Feature Pocket Area Clearance strategy. 

 Feature Pocket Rest Profile (see page 66) adds rest machining 
options to the Feature Pocket Profile strategy. 

 Feature Profile (see page 71) machines a profile around the 
feature at each Z height. 

 Feature Rest Area Clearance (see page 75) adds rest machining 
options to the Feature Area Clearance strategy. 

 Feature Rest Profile (see page 81) adds rest machining options to 
the Feature Profile strategy. 

 Feature Slot Machining (see page 86) — machines slot features in 
a model. 
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Feature Area Clearance Overview 
Use the Feature Area Clearance strategy to rapidly remove material 
from a 2.5D part. Offset toolpaths work well in the bottom of 
pockets whereas raster toolpaths are often used on open parts. 
Vortex machining enables you to increase the feed rate whilst 
maintaining surface quality and tool life. 

 

 Feature area clearance machines the active feature group.  
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There are several pages associated with the Feature Area Clearance 
strategy: 

 
 Feature area clearance (see page 30) — The main page used to 

choose the area clearance styles and associated settings. 

 Raster — Settings to define a raster area clearance style. This 
page is available when you select a Style of Raster on the main 
page. 

 Offset — Settings to define offset area clearance styles. This 
page is available when you select a Style of Offset model or Offset 
all on the main page. 

 Vortex — Settings to define a Vortex area clearance style. This 
page is available when you select a Style of Vortex on the main 
page. 

 Step cutting — Settings to define in-line rest roughing. This 
minimises terracing when creating area clearance toolpaths with 
a large stepdown. This is available when you select a Stepdown 
of Automatic. 
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 Finishing — Settings to perform a Final Stepover and a Final 
Stepdown which are different from the normal stepover and 
stepdown. 

 Unsafe segment removal — Settings to remove small toolpath 
segments. 

 High speed — Settings for the smoothing options to avoid sharp 
changes in tool direction when high speed machining. 

 Order — Settings to control the order of machining. 

 Approach — Settings to control how the tool approaches the 
path. 

 Automatic verification — Settings to automatically verify toolpaths 
on creation. 

The remaining pages are common toolpath creation controls. 
 

Feature area clearance 
Use the Feature area clearance page to create a toolpath by slicing 
the features at specified Z heights and then create an offset or 
raster pass at each Z height. 

 
Style — Select the raster, offset, or Vortex style to use for removing 
material. 
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Cut direction — Select a milling style for Profile and Area. 

Tolerance — Enter a value to determine how accurately the toolpath 
follows the contours of the model. 

Thickness — Enter the amount of material to be left on the part. 

 Component thickness — Click to display the Component thickness 
dialog, which enables you to specify the thicknesses of the different 
surfaces. 

Stepover — Enter the distance between successive area clearance 
passes at a single Z height. 

 Copy stepover from tool — Click to load the radial depth of cut 
from the active tool's cutting data. The radial depth of cut is 
measured normal to the tool axis. 

 If you enter the value manually, the button changes to . 

Stepdown — Enter the distance between different machining levels. 

 Copy stepdown from tool — Click to load the axial depth of cut 
from the active tool's cutting data. The axial depth of cut is 
measured along the tool axis. 

 If you enter the value manually, the button changes to . 

Constant Stepdown — When selected, all the machining levels are 
equispaced, and the Stepdown value is a maximum stepdown. When 
deselected, the difference between consecutive machining levels is 
the Stepdown value for all levels except the last one which is at the 
bottom of the block. 

 This option is only available if you select a Stepdown of 
Automatic. If you select a Stepdown of Manual, the Constant 
Stepdown option is available on the Area Clearance Z Heights 
dialog. 

Rest machining — Select to change the strategy to Feature Rest Area 
Clearance and make the Rest page available with the options for 
rest machining. This option is not selected by default for this 
strategy. 

Ignore chamfers — When selected the chamfers are not machined. 

Ignore top fillets — When selected the top fillets are not machined. 
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Feature Chamfer Milling Overview 
Use the Feature Chamfer Milling strategy to bevel sharp corners 
using specific chamfer tools where the chamfer information is 
specified by the feature geometry. Feature chamfer milling is used 
to break sharp outside-edges of a model after it has been 
completely machined. Feature chamfer milling: 

 minimises hand deburring operations 

 improves part assembly, by adding a taper to one or both mating 
edges 

 is used for aesthetic and safety reasons. 

In many cases feature chamfer milling is used to produce a single 
finishing pass as chamfer tools are generally larger than the 
chamfer feature. 
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There are several pages associated with the Feature Chamfer Milling 
strategy: 

 
 Feature chamfer milling (see page 34) — The main page to specify 

the options for the feature chamfer milling strategy. 

 Order — Settings to control the order of machining. 

 Automatic verification — Settings to automatically verify toolpaths 
on creation. 

The remaining pages are common toolpath creation controls. 
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Feature chamfer milling 
Use the Feature chamfer milling page to specify the cutting range in 
the axial and radial directions of the tool. 

 

Axial 

Multiple cuts are generated along the axial direction. 
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 Limit — Defined by the block, the chamfer feature or the number 
of cuts. 

 Stepdown 

Extent — Select how to calculate the limits of multiple passes. 

Number of cuts — Enter a number to limit the number of passes. 

Chamfer extent — Machine the total height of the chamfer. 

Stock extent — Machine the distance between the tool start position 
and the end of the block. 

Extra depth — Specify an extra distance above and below the 
chamfer for your toolpath range. 

 This option is only available for when you select an Extent of 
Chamfer extent. 

Stepdown — Enter the maximum distance between successive 
passes. 
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 Copy stepdown from tool — Click to load the axial depth of cut 
from the active tool's cutting data. The axial depth of cut is 
measured along the tool axis. 

If you enter the value manually, the button changes to . 

Tool position — Select the position of the tool relative to the 
chamfer. 

 Top axial depth — The distance the tool extends above the 
top of the chamfer.  

 

 — Top axial depth 

 Bottom axial depth — The distance the tool extends below the 
bottom of the chamfer. 

 

 — Bottom axial depth 
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 Gauge diameter — The effective tool diameter at the contact 
point of the tool on the chamfer. 

 

 — Gauge diameter 

  

Radial 

Multiple cuts are generated along the radial direction. 
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 Limit — Defined by the block, the chamfer feature or the number 
of cuts. 

 Stepover 

Extent — Select how to calculate the limits of multiple passes. 

Number of cuts — Enter a number to limit the number of passes. 

Chamfer extent — Machine the total width of the chamfer. 

Stock extent — Machine the distance between the tool start position 
and the end of the block. 

Extra width — Specify an extra distance radially around the chamfer 
for your toolpath range. 

 This option is only available for when you select an Extent of 
Chamfer extent. 
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Stepover — Enter the distance between successive area clearance 
passes at a single Z height. 

 Copy stepover from tool — Click to load the radial depth of cut 
from the active tool's cutting data. The radial depth of cut is 
measured normal to the tool axis. 

If you enter the value manually, the button changes to . 

 These options are only available when you select an Extent of 
Chamfer extent or Stock extent. 

  

Other options 

Tolerance — Enter a tolerance value to determine how accurately 
the toolpath follows the feature. 

Cut direction — Select the milling technology. 

Thickness — Enter the amount of material to be left on the part. 
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Feature External Thread Milling Overview 
Use the Feature External Thread Milling strategy to create an external 
thread on a boss. 

  

 To create an external thread you must use a thread mill tool. 
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There are several pages associated with the Feature external thread 
milling strategy: 

 
 Feature external thread milling (see page 42) — The main page 

used to define an external thread. 

 Helical leads (see page 44) — Settings to control the lead angle 
and the lead radius. 

 Order — Settings to control the order of machining. 

 Automatic verification — Settings to automatically verify toolpaths 
on creation. 

For more information on the Strategy Selector dialog, see Toolpath 
Strategies. 

The common tabs are described in common toolpath creation 
controls. 
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Feature external thread milling 
Use the Feature external thread milling page to create an external 
thread. 

 
Depth type — Select how to determine the maximum thread depth. 

Feature — The thread starts at the base of the boss. This disables 
the Depth field as PowerMill calculates this value. 

User defined — The thread starts at a distance below the top of 
the boss. Enter this distance in the Depth field. 

Depth — Enter the maximum thread depth. This option is only 
available if you select a Depth type of User defined .If you select a 
Depth type of Feature, PowerMill calculates this values for you. 

Clearance — Enter the distance above the top of the boss. By 
default, this is the same as the Incremental start Z. 

Turns — Enter the number of turns of the thread milling tool. Tall 
bosses may need more than one turn. 

Pitch — Enter the distance from one thread groove to the next. 

Tolerance — Enter a tolerance value to determine how accurately 
the toolpath follows the boss. 

Number of start positions — Enter a value to create identical 
toolpaths that are rotated about the tool axis and spaced 
equidistantly. This enables you to generate intertwined threads. 
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Toolpath with one start 
position 

 

Toolpath with three start 
positions 

 
 

Radial passes— Enter the number of radially spaced helical 
toolpaths. 

One pass: 

 
Three passes: 

 
Stepover — Enter the distance between successive passes. 
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Cut Direction — Select the milling technology. The combination of 
Cut Direction and Handedness determines the cut direction. 

 
 Right hand thread Left hand thread 

Climb Clockwise, 
downwards 

Clockwise, upwards 

Conventional Anti-clockwise, 
upwards 

Anti-clockwise, 
downwards 

 

Handedness — Select the rotational direction of the thread as it 
moves in the positive Z direction. 

Thickness — Enter the amount of material to be left on the part. 
 

Helical leads 
Use the Helical leads page to specify the arc angle and radius of the 
toolpath leads. 

 
Lead angle — Enter a value to specify the arc angle of the toolpath 
leads. This angle must be greater than 5 . 
Lead angle at 90  Lead angle at 180  
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User defined lead radius — Select this option to manually specify the 
arc radius of the toolpath leads. 

 

Creating an external thread 
This example shows you how to create an external thread on a 
boss. It uses the 2DExample.dgk model in the Examples folder. 

 
1 Create a feature group containing the three bosses.  

 You can create this as a pocket with three bosses. 

 
2 Calculate the block and create a thread mill tool. 

3 On the Main toolbar, select the Toolpath strategies  button. 

4 Select the Feature Machining tab, followed by the Feature External 
Thread Milling option. 
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5 On the Feature external thread milling page: 

 
a Select a Depth Type of Feature. 

b Enter a Clearance of 0. 

c Enter a Turns of 3. 

d Enter a Pitch of 2. 

e Click Calculate. 
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Looking in detail: 
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Feature Face Milling Overview 
Use the Feature Face Milling strategy to produce flat surfaces by 
guiding a large cutter over the surface of the workpiece specified by 
bounded or unbounded face features. This strategy enables you to 
machine multiple face features at different Z heights. 

The cutter is a Face Mill consisting of a rotating holder containing 
turning inserts. The cutter spindle always has an axis of rotation 
perpendicular to the work piece surface. The geometry of the cutter 
only enables relatively small depths of cut. Face milling is commonly 
used to machine flat surfaces on ground vehicle powertrain 
components, engine blocks, and transmission valve bodies. 
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There are several pages associated with the Feature Face Milling 
strategy: 

 
 Feature face milling (see page 50) — The main page used to 

specify a face milling toolpath. 

 Finishing — Setting to specify a final stepdown depth of cut 
value. 

 Raster — Settings to specify a raster area clearance style. 

 Offset — Settings to specify an offset area clearance style 

 High speed — Settings to control smoothing options to avoid 
sharp changes in tool direction when high speed machining. This 
page is only available for offset area clearance styles. 

 Automatic verification — Settings to automatically verify toolpaths 
on creation. 

The remaining pages are common toolpath creation controls. 

To create a Face Milling toolpath you must define a block and a tool. 
Face milling works with any tool and uses the flat end of the tool. 
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Feature face milling 
Use the Feature face milling page to specify the feature face 
machining parameters. 

 
XY expansion — Enter an allowance in the X and Y directions on the 
block. This is useful where the actual stock is larger than the 
PowerMill block as it ensures that the face milling toolpath machines 
all of the stock. 

Engagement feed rate (%) — Enter a value to control the feed rate of 
the toolpath, as it approaches the block, until it fully engages with 
the block. This is useful to prevent tool inserts from breaking when 
they plunge into the model with high feed rate. By default this is set 
to 100% so there is no engagement feed rate reduction. 
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 - Cutting feed rate 

 - Engagement feed rate 

 - Plunging feed rate 

 Any lead in applied to the toolpath will also acquire the 
engagement feed rate. 

Tolerance — Enter a value to determine how closely the toolpath 
follows the feature. 

Style — Select the Raster or Offset style to use for removing 
material. 

Stepover — Enter the distance between successive machining 
passes. 

 Copy stepover from tool — Click to load the radial depth of cut 
from the active tool's cutting data. The radial depth of cut is 
measured normal to the tool axis. 

 If you enter the value manually, the button changes to . 

Stepdown 

Stock depth — Enter the total depth of material to remove. 
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Stepdown — Enter the maximum distance between successive 
passes. 

 

 Copy stepover from tool — Click to load the radial depth of cut 
from the active tool's cutting data. The radial depth of cut is 
measured normal to the tool axis. 

 If you enter the value manually, the button changes to . 
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Feature Pocket Area Clearance Overview 
Use the Feature Pocket Area Clearance strategy to efficiently remove 
large volumes of material for individual pocket features using one 
strategy. This strategy enables you to machine multiple pockets at 
different Z levels. 
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There are several pages associated with the Feature Pocket Area 
Clearance strategy: 

 
 Feature pocket area clearance (see page 55) — The main page 

used to specify a feature pocket area clearance toolpath. 

 Raster — Settings to define a raster area clearance style. This 
page is available when you select a Style of Raster on the main 
page. 

 Offset — Settings to define offset area clearance styles. This 
page is available when you select a Style of Offset model or Offset 
all on the main page. 

 Vortex — Settings to define a Vortex area clearance style. This 
page is available when you select a Style of Vortex on the main 
page. 

 Step cutting — Settings to define in-line rest roughing. This 
minimises terracing when creating area clearance toolpaths with 
a large stepdown. This is available when you select a Stepdown 
of Automatic. 
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 Finishing — Settings to perform a Final Stepover and a Final 
Stepdown which are different from the normal stepover and 
stepdown. 

 Unsafe segment removal — Settings to remove small toolpath 
segments. 

 High speed — Settings to control smoothing options to avoid 
sharp changes in tool direction when high speed machining. This 
page is only available for offset area clearance styles. 

 Order — Settings to control the order of machining. 

 Approach — Settings to control how the tool approaches the 
path. 

 Automatic verification — Settings to automatically verify toolpaths 
on creation. 

The remaining pages are common toolpath creation controls. 
 

Feature pocket area clearance 
Use the Feature pocket area clearance page to create a toolpath by 
slicing the pocket features at specified Z heights and then creates 
an offset or raster pass at each Z height. You can machine multiple 
pockets at different Z heights using one strategy. 
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Style — Select the raster, offset, or Vortex style to use for removing 
material. 

Cut direction — Select a milling style for Profile and Area. 

Tolerance — Enter a value to determine how accurately the toolpath 
follows the contours of the model. 

Thickness — Enter the amount of material to be left on the part. 

 Component thickness — Click to display the Component thickness 
dialog, which enables you to specify the thicknesses of the different 
surfaces. 

Stepover — Enter the distance between successive area clearance 
passes at a single Z height. 

 Copy stepover from tool — Click to load the radial depth of cut 
from the active tool's cutting data. The radial depth of cut is 
measured normal to the tool axis. 

 If you enter the value manually, the button changes to . 

Stepdown — Enter the distance between different machining levels. 

 Copy stepdown from tool — Click to load the axial depth of cut 
from the active tool's cutting data. The axial depth of cut is 
measured along the tool axis. 

 If you enter the value manually, the button changes to . 

Constant Stepdown — When selected, all the machining levels are 
equispaced, and the Stepdown value is a maximum stepdown. When 
deselected, the difference between consecutive machining levels is 
the Stepdown value for all levels except the last one which is at the 
bottom of the block. 

This option is only available if you select a Stepdown of Automatic. If 
you select a Stepdown of Manual, the Constant Stepdown option is 
available on the Area Clearance Z Heights dialog. 

Rest machining — Select to change the strategy to Feature pocket 
rest area clearance and make the Rest page available with the 
options for rest machining. This option is not selected by default for 
this strategy. 

Ignore chamfers — When selected the chamfers are not machined. 

Ignore top fillets — When selected the top fillets are not machined. 

 



 

Autodesk PowerMill 2017  2D Machining • 57  

Feature Pocket Profile Overview 
Use the Feature Pocket Profile strategy to create a simple toolpath 
that slices the pocket features at specified Z heights and then 
machines the pocket features profiles at each Z height. This 
strategy enables you to machine multiple pockets at different Z 
levels. 
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There are several pages associated with the Feature Pocket Profile 
strategy: 

 
 Feature pocket profile (see page 59) — The main page used to 

specify a feature pocket profile strategy 

 Step cutting — Settings to define in-line rest roughing. This 
minimises terracing when creating area clearance toolpaths with 
a large stepdown. This is available when you select a Stepdown 
of Automatic. 

 Cut distances — Settings to control the number of profile cuts. 

 Finishing — Settings to perform a Final Stepover and a Final 
Stepdown which are different from the normal stepover and 
stepdown. 

 Unsafe segment removal — Settings to remove small toolpath 
segments. 

 High speed — Settings to control smoothing options to avoid 
sharp changes in tool direction when high speed machining. This 
page is only available for offset area clearance styles. 
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 Order — Settings to control the order of machining. 

 Approach — Settings to control how the tool approaches the 
path. 

 Automatic verification — Settings to automatically verify toolpaths 
on creation. 

The remaining pages are common toolpath creation controls. 
 

Feature pocket profile 
Use the Feature pocket profile page to create a toolpath by slicing 
the pocket features at specified Z heights and then creates a profile 
pass at each Z height. You can machine multiple pockets at 
different Z heights using one strategy. The Z heights are defined 
from the previous area clearance toolpath and are used to eliminate 
large terraces. 

 
Cut direction — Select the milling technology. When you have 
several profile passes you can have a different cut direction for the 
final profile pass. 

Profile — Select the cut direction of the final profiling pass. 

Additional profiles — Select the cut direction of all passes except the 
final profiling pass. 
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Tolerance — Enter a value to determine how accurately the toolpath 
follows the contours of the model. 

Thickness — Enter the amount of material to be left on the part. 

 Component thickness — Click to display the Component thickness 
dialog, which enables you to specify the thicknesses of the different 
surfaces. 

Stepover — Enter the distance between successive machining 
passes. 

 Copy stepover from tool — Click to load the radial depth of cut 
from the active tool's cutting data. The radial depth of cut is 
measured normal to the tool axis. 

 If you enter the value manually, the button changes to . 

Stepdown — Enter the distance between different machining levels. 

 Copy stepdown from tool — Click to load the axial depth of cut 
from the active tool's cutting data. The axial depth of cut is 
measured along the tool axis. 

 If you enter the value manually, the button changes to . 

Constant Stepdown — When selected, all the machining levels are 
equispaced, and the Stepdown value is a maximum stepdown. When 
deselected, the difference between consecutive machining levels is 
the Stepdown value for all levels except the last one which is at the 
bottom of the block. 

 This option is only available if you select a Stepdown of 
Automatic. If you select a Stepdown of Manual, the Constant 
Stepdown option is available on the Area Clearance Z Heights 
dialog. 

Rest machining — Select to change the strategy to Feature pocket 
rest area clearance and make the Rest page available with the 
options for rest machining. This option is not selected by default for 
this strategy. 

Ignore chamfers — When selected the chamfers are not machined. 

Ignore top fillets — When selected the top fillets are not machined. 
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Feature Pocket Rest Area Clearance Overview 
Use the Feature Pocket Rest Area Clearance strategy after a pocket 
area clearance strategy to rough areas of the pocket features using 
a small tool, that a large tool could not reach. This strategy enables 
you to machine multiple pockets at different Z levels. 
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There are several pages associated with the Feature Pocket Rest Area 
Clearance strategy: 

 
 Feature pocket rest area clearance (see page 64) — The main page 

used to specify a feature pocket rest area clearance toolpath. 

 Rest — Settings to define rest machining. 

 Raster — Settings to define a raster area clearance style. This 
page is available when you select a Style of Raster on the main 
page. 

 Offset — Settings to define offset area clearance styles. This 
page is available when you select a Style of Offset model or Offset 
all on the main page. 

 Vortex — Settings to define a Vortex area clearance style. This 
page is available when you select a Style of Vortex on the main 
page. 
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 Step cutting — Settings to define in-line rest roughing. This 
minimises terracing when creating area clearance toolpaths with 
a large stepdown. This is available when you select a Stepdown 
of Automatic. 

 Finishing — Settings to perform a Final Stepover and a Final 
Stepdown which are different from the normal stepover and 
stepdown. 

 Unsafe segment removal — Settings to remove small toolpath 
segments. 

 High speed — Settings to control smoothing options to avoid 
sharp changes in tool direction when high speed machining. This 
page is only available for offset area clearance styles. 

 Order — Settings to control the order of machining. 

 Approach — Settings to control how the tool approaches the 
path. 

 Automatic verification — Settings to automatically verify toolpaths 
on creation. 

The remaining pages are common toolpath creation controls. 
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Feature pocket rest area clearance 
Use the Feature pocket rest area clearance page to create a toolpath 
by slicing the pocket features at specified Z heights and then 
creates an offset or raster pass at each Z height. You can machine 
multiple pockets at different Z heights using one strategy. 

 
Style — Select the raster, offset, or Vortex style to use for removing 
material. 

Cut direction — Select a milling style for Profile and Area. 

Tolerance — Enter a value to determine how accurately the toolpath 
follows the contours of the model. 

Thickness — Enter the amount of material to be left on the part. 

 Component thickness — Click to display the Component thickness 
dialog, which enables you to specify the thicknesses of the different 
surfaces. 

Stepover — Enter the distance between successive area clearance 
passes at a single Z height. 

 Copy stepover from tool — Click to load the radial depth of cut 
from the active tool's cutting data. The radial depth of cut is 
measured normal to the tool axis. 
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 If you enter the value manually, the button changes to . 

Stepdown — Enter the distance between different machining levels. 

 Copy stepdown from tool — Click to load the axial depth of cut 
from the active tool's cutting data. The axial depth of cut is 
measured along the tool axis. 

 If you enter the value manually, the button changes to . 

Constant Stepdown — When selected, all the machining levels are 
equispaced, and the Stepdown value is a maximum stepdown. When 
deselected, the difference between consecutive machining levels is 
the Stepdown value for all levels except the last one which is at the 
bottom of the block. 

This option is only available if you select a Stepdown of Automatic. If 
you select a Stepdown of Manual, the Constant Stepdown option is 
available on the Area Clearance Z Heights dialog. 

Rest machining — Select to enable the Rest page which contains the 
options for rest machining. If deselected, the strategy switches to 
the Feature Pocket Area Clearance strategy. This option is selected by 
default in this strategy. 

Ignore chamfers — When selected the chamfers are not machined. 

Ignore top fillets — When selected the top fillets are not machined. 
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Feature Pocket Rest Profile Overview 
Use the Feature Pocket Rest Profile strategy that creates a toolpath 
around the pocket profile after the pocket has been roughed using 
an area clearance strategy. This strategy enables you to machine 
multiple pockets at different Z levels. 
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There are several pages associated with the Feature Pocket Rest 
Profile strategy: 

 
 Feature pocket rest profile (see page 68) — The main page used 

to specify a feature pocket rest profile toolpath. 

 Rest — Settings to define rest machining. 

 Step cutting — Settings to define in-line rest roughing. This 
minimises terracing when creating area clearance toolpaths with 
a large stepdown. This is available when you select a Stepdown 
of Automatic. 

 Cut distances — Settings to control the number of profile cuts. 

 Finishing — Settings to perform a Final Stepover and a Final 
Stepdown which are different from the normal stepover and 
stepdown. 

 Unsafe segment removal — Settings to remove small toolpath 
segments. 

 High speed — Settings for the smoothing options to avoid sharp 
changes in tool direction when high speed machining. 
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 Order — Settings to control the order of machining. 

 Approach — Settings to control how the tool approaches the 
path. 

 Automatic verification — Settings to automatically verify toolpaths 
on creation. 

The remaining pages are common toolpath creation controls. 
 

Feature pocket rest profile 
Use the Feature pocket rest profile page to create a toolpath by 
slicing the pocket features at specified Z heights and then creates a 
profile pass at each Z height. You can machine multiple pockets at 
different Z heights using one strategy. The Z heights are defined 
from the previous area clearance toolpath and are used to eliminate 
large terraces. 

 
Cut direction — Select the milling technology. When you have 
several profile passes you can have a different cut direction for the 
final profile pass. 

Profile — Select the cut direction of the final profiling pass. 

Additional profiles — Select the cut direction of all passes except the 
final profiling pass. 
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Tolerance — Enter a value to determine how accurately the toolpath 
follows the contours of the model. 

Thickness — Enter the amount of material to be left on the part. 

 Component thickness — Click to display the Component thickness 
dialog, which enables you to specify the thicknesses of the different 
surfaces. 

Stepover — Enter the distance between successive machining 
passes. 

 Copy stepover from tool — Click to load the radial depth of cut 
from the active tool's cutting data. The radial depth of cut is 
measured normal to the tool axis. 

 If you enter the value manually, the button changes to . 

Stepdown — Enter the distance between different machining levels. 

 Copy stepdown from tool — Click to load the axial depth of cut 
from the active tool's cutting data. The axial depth of cut is 
measured along the tool axis. 

 If you enter the value manually, the button changes to . 

Constant Stepdown — When selected, all the machining levels are 
equispaced, and the Stepdown value is a maximum stepdown. When 
deselected, the difference between consecutive machining levels is 
the Stepdown value for all levels except the last one which is at the 
bottom of the block. 

Constant Stepdown deselected: 

 
With a Stepdown of 20, the Z heights are at 15, -5, and -10. 
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The stepdown is the amount specified for all levels (in this case 20) 
except for the last one, which is at the bottom of the block (in this 
case a Stepdown of 5). 

Constant Stepdown selected: 

 
With a Stepdown of 20, the Z heights are at 20, 5, and-10. This 
gives an effective stepdown of 15. 

The stepdown is the same between all levels but is not necessarily 
the amount specified. In this case, PowerMill uses a Stepdown of 15 
rather than 20. 

 This option is only available if you select a Stepdown of 
Automatic. If you select a Stepdown of Manual, the Constant 
Stepdown option is available on the Area Clearance Z Heights 
dialog. 

Rest machining — Select to enable the Rest page which contains the 
options for rest machining. If deselected, the strategy switches to 
the Feature Pocket Profile strategy. This option is selected by default 
in this strategy. 

Ignore chamfers — When selected the chamfers are not machined. 

Ignore top fillets — When selected the top fillets are not machined. 
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Feature Profile Overview 
Use the Feature Profile strategy to create a toolpath by slicing the 
feature set at specified Z heights and then machines the feature 
profiles at each Z height. 
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There are several pages associated with the Feature Profile strategy: 

 
 Feature profile (see page 73) — The main page used to machine a 

feature using a profile strategy. 

 Step cutting — Settings to define in-line rest roughing. This 
minimises terracing when creating area clearance toolpaths with 
a large stepdown. This is available when you select a Stepdown 
of Automatic. 

 Cut distances — Settings to control the number of profile cuts. 

 Finishing — Settings to perform a Final Stepover and a Final 
Stepdown which are different from the normal stepover and 
stepdown. 

 Unsafe segment removal — Settings to remove small toolpath 
segments. 

 High speed — Settings to control smoothing options to avoid 
sharp changes in tool direction when high speed machining. This 
page is only available for offset area clearance styles. 

 Order — Settings to control the order of machining. 
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 Approach — Settings to control how the tool approaches the 
path. 

 Automatic verification — Settings to automatically verify toolpaths 
on creation. 

The remaining pages are common toolpath creation controls. 
 

Feature profile 
Use the Feature profile page to create a toolpath by slicing the 
features at specified Z heights and then machines the feature 
profiles at each Z height. 

 
Cut direction — Select the milling technology. When you have 
several profile passes you can have a different cut direction for the 
final profile pass. 

Profile — Select the cut direction of the final profiling pass. 

Additional profiles — Select the cut direction of all passes except the 
final profiling pass. 

Tolerance — Enter a value to determine how accurately the toolpath 
follows the contours of the model. 

Thickness — Enter the amount of material to be left on the part. 



 

74 • 2D Machining  What's New  

 Component thickness — Click to display the Component thickness 
dialog, which enables you to specify the thicknesses of the different 
surfaces. 

Stepover — Enter the distance between successive machining 
passes. 

 Copy stepover from tool — Click to load the radial depth of cut 
from the active tool's cutting data. The radial depth of cut is 
measured normal to the tool axis. 

 If you enter the value manually, the button changes to . 

Stepdown — Enter the distance between different machining levels. 

 Copy stepdown from tool — Click to load the axial depth of cut 
from the active tool's cutting data. The axial depth of cut is 
measured along the tool axis. 

 If you enter the value manually, the button changes to . 

Constant Stepdown — When selected, all the machining levels are 
equispaced, and the Stepdown value is a maximum stepdown. When 
deselected, the difference between consecutive machining levels is 
the Stepdown value for all levels except the last one which is at the 
bottom of the block. 

 This option is only available if you select a Stepdown of 
Automatic. If you select a Stepdown of Manual, the Constant 
Stepdown option is available on the Area Clearance Z Heights 
dialog. 

Rest machining — Select to change the strategy to Feature Rest 
Profile and make the Rest page available with additional options for 
rest machining. This option is not selected by default in this 
strategy. 

Ignore chamfers — When selected the chamfers are not machined. 

Ignore top fillets — When selected the top fillets are not machined. 
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Feature Rest Area Clearance Overview 
Use the Feature Rest Area Clearance strategy to eliminate large 
terraces. Area clearance strategies carry out efficient volume 
removal with a large tool and then rest area clearance strategies 
use a smaller tool to rough areas of the feature set that the large 
tool could not reach, such as pockets and corners. 

This is easier to see looking at a ViewMill simulation. 

If you start with an area clearance toolpath: 
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A feature rest area clearance toolpath, based on this area clearance 
toolpath, gives: 
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There are several pages associated with the Feature Rest Area 
Clearance strategy: 

 
 Feature rest area clearance (see page 79) — The main page used 

to choose the area clearance styles and associated settings. 

 Rest — Settings to define rest machining. 

 Raster — Settings to define a raster area clearance style. This 
page is available when you select a Style of Raster on the main 
page. 

 Offset — Settings to define offset area clearance styles. This 
page is available when you select a Style of Offset model or Offset 
all on the main page. 

 Vortex — Settings to define a Vortex area clearance style. This 
page is available when you select a Style of Vortex on the main 
page. 
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 Step cutting — Settings to define in-line rest roughing. This 
minimises terracing when creating area clearance toolpaths with 
a large stepdown. This is available when you select a Stepdown 
of Automatic. 

 Finishing — Settings to perform a Final Stepover and a Final 
Stepdown which are different from the normal stepover and 
stepdown. 

 Unsafe segment removal — Settings to remove small toolpath 
segments. 

 High speed — Settings to control smoothing options to avoid 
sharp changes in tool direction when high speed machining. This 
page is only available for offset area clearance styles. 

 Order — Settings to control the order of machining. 

 Approach — Settings to control how the tool approaches the 
path. 

 Automatic verification — Settings to automatically verify toolpaths 
on creation. 

 Cutter compensation is not available for rest machining 
strategies. 

The remaining pages are common toolpath creation controls. 
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Feature rest area clearance 
Use the Feature rest area clearance page to create a toolpath by 
slicing the feature set at specified Z heights and then creates an 
offset or raster pass at each Z height. The Z heights are defined 
from the previous area clearance toolpath and are used to eliminate 
large terraces. 

 
Style — Select the raster, offset, or Vortex style to use for removing 
material. 

Cut direction — Select a milling style for Profile and Area. 

Tolerance — Enter a value to determine how accurately the toolpath 
follows the contours of the model. 

Thickness — Enter the amount of material to be left on the stock 
within tolerance. 

 Component thickness — Click to display the Component thickness 
dialog, which enables you to specify the thicknesses of the different 
surfaces. 

Stepover — Enter the distance between successive machining 
passes. 
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 Copy stepover from tool — Click to load the radial depth of cut 
from the active tool's cutting data. The radial depth of cut is 
measured normal to the tool axis. 

 If you enter the value manually, the button changes to . 

Stepdown — Enter the distance between different machining levels. 

 Copy stepdown from tool — Click to load the axial depth of cut 
from the active tool's cutting data. The axial depth of cut is 
measured along the tool axis. 

 If you enter the value manually, the button changes to . 

Constant Stepdown — When selected, all the machining levels are 
equispaced, and the Stepdown value is a maximum stepdown. When 
deselected, the difference between consecutive machining levels is 
the Stepdown value for all levels except the last one which is at the 
bottom of the block. 

 This option is only available if you select a Stepdown of 
Automatic. If you select a Stepdown of Manual, the Constant 
Stepdown option is available on the Area Clearance Z Heights 
dialog. 

Rest machining — Select to enable the Rest page which contains the 
options for rest machining. If deselected, the strategy switches to 
the Feature Area Clearance strategy. This option is selected by 
default in this strategy. 

Ignore chamfers — When selected the chamfers are not machined. 

Ignore top fillets — When selected the top fillets are not machined. 
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Feature Rest Profile Overview 
Use the Feature Rest Profile strategy to eliminate large terraces. 
Area clearance strategies carry out efficient volume removal with a 
large tool and then rest area clearance strategies use a smaller tool 
to rough areas of the feature set profile that the large tool could not 
reach, such as pockets and corners. 

This is easier to see looking at a ViewMill simulation. 

If you start with an area clearance toolpath: 
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A feature rest area clearance toolpath, based on this area clearance 
toolpath, gives: 
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There are several pages associated with the Feature Rest Profile 
strategy: 

 
 Feature rest profile (see page 84) — The main page which contain 

settings to machine a feature using a rest profile strategy. 

 Rest — Settings to define rest machining. 

 Step cutting — Settings to define in-line rest roughing. This 
minimises terracing when creating area clearance toolpaths with 
a large stepdown. This is available when you select a Stepdown 
of Automatic. 

 Cut distances — Settings to control the number of profile cuts. 

 Finishing — Settings to perform a Final Stepover and a Final 
Stepdown which are different from the normal stepover and 
stepdown. 

 Unsafe segment removal — Settings to remove small toolpath 
segments. 
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 High speed — Settings to control smoothing options to avoid 
sharp changes in tool direction when high speed machining. This 
page is only available for offset area clearance styles. 

 Order — Settings to control the order of machining. 

 Approach — Settings to control how the tool approaches the 
path. 

 Automatic verification — Settings to automatically verify toolpaths 
on creation. 

 Cutter compensation is not available for rest machining 
strategies. 

The remaining pages are common toolpath creation controls. 
 

Feature rest profile 
Use the Feature rest profile page to create a toolpath by slicing the 
feature set at specified Z heights and then creates profile pass at 
each Z height. The Z heights are defined from the previous area 
clearance toolpath and are used to eliminate large terraces. 

 
Cut direction — Select the milling technology. When you have 
several profile passes you can have a different cut direction for the 
final profile pass. 
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Profile — Select the cut direction of the final profiling pass. 

Additional profiles — Select the cut direction of all passes except the 
final profiling pass. 

Tolerance — Enter a value to determine how accurately the toolpath 
follows the contours of the model. 

Thickness — Enter the amount of material to be left on the part. 

 Component thickness — Click to display the Component thickness 
dialog, which enables you to specify the thicknesses of the different 
surfaces. 

Stepover — Enter the distance between successive machining 
passes. 

 Copy stepover from tool — Click to load the radial depth of cut 
from the active tool's cutting data. The radial depth of cut is 
measured normal to the tool axis. 

 If you enter the value manually, the button changes to . 

Stepdown — Enter the distance between different machining levels. 

 Copy stepdown from tool — Click to load the axial depth of cut 
from the active tool's cutting data. The axial depth of cut is 
measured along the tool axis. 

 If you enter the value manually, the button changes to . 

Constant Stepdown — When selected, all the machining levels are 
equispaced, and the Stepdown value is a maximum stepdown. When 
deselected, the difference between consecutive machining levels is 
the Stepdown value for all levels except the last one which is at the 
bottom of the block. 

 This option is only available if you select a Stepdown of 
Automatic. If you select a Stepdown of Manual, the Constant 
Stepdown option is available on the Area Clearance Z Heights 
dialog. 

Rest machining — Select to enable the Rest page which contains the 
options for rest machining. If deselected, the strategy switches to 
Feature Profile strategy. This option is selected by default in this 
strategy. 

Ignore chamfers — When selected the chamfers are not machined. 

Ignore top fillets — When selected the top fillets are not machined. 
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Feature Slot Machining Overview 
Use the Feature slot machining strategy to machine all slot features 
in a feature group. 

 
There are several pages associated with the Feature Slot Machining 
strategy: 

 
 Feature slot machining (see page 87) — The main page used to 

specify a feature slot machining toolpath. 

 Order — Settings to control the order of machining. 
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 Automatic verification — Settings to automatically verify toolpaths 
on creation. 

The remaining pages are common toolpath creation controls. 
 

Feature slot machining 
Use the Feature slot machining page to create a toolpath that 
machines slot features in a feature group. 

 
Stepdown — Enter the distance between different machining levels. 

 Copy stepdown from tool — Click to load the axial depth of cut 
from the active tool's cutting data. The axial depth of cut is 
measured along the tool axis. 

 If you enter the value manually, the button changes to . 

Floor only — Select to create one toolpath along the base of the slot 
channel. 

Thickness — Enter the amount of material to be left on the part. 

 Component thickness — Click to display the Component thickness 
dialog, which enables you to specify the thicknesses of the different 
surfaces. 

Tolerance — Enter a value to determine how accurately the toolpath 
follows the contours of the model. 
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Creating a 2D feature strategy example 
To create a 2D feature machining toolpath: 

1 In the Main toolbar, click Toolpath strategies , or right-click 
Toolpaths in the Explorer and select Create toolpath. 

2 Select the new Feature Machining page in the Strategy Selector 
dialog. 

 
3 Select a new feature strategy and click OK to display the strategy 

dialog. 
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For example, selecting Feature Face Milling displays the Feature 
face milling page of the Feature Face Milling strategy dialog. 

 
4 On the Features page, select the Feature group that contains the 

feature you want to machine. 

5 Click the features on the model you want to machine. Use Ctrl + 
Click on a feature to remove it from your selection. 

Alternatively use the buttons on the Features page to select the 
features: 

  Select all — Click to select all features. 

  Select toggle  — Click to deselect the selected features and 
select the deselected features. 

  Deselect all — Click to deselect all features. 

6 Click Calculate to calculate the toolpath. 

7 Click OK to close the dialog. 
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You can now create toolpaths for turned parts in PowerMill. 

You can program a turning part without a model using features, or 
you can extract information from a model. 

  

To program a turning part: 

1 Set the View mode to turning (see page 90). 

2 Create (and activate) a Workplane (see page 91). 

3 Create the turning curves (see page 92). 

4 Create the turning features (see page 96). 

5 Create or import turning tools (see page 98). 

6 Create the turning toolpaths (see page 102). 

7 Simulate the turning toolpaths (see page 104). 
 

View mode 
Set the view mode to determine how the part is orientated by the 
standard views. 

Use the new buttons on the Viewing toolbar to set the view mode: 

  Turning view — Select this option to use the turning standard 
views, where the Z axis is horizontal in the graphics window. For 
example, the top view displays the ZX plane. 

  Milling view — Select this option to use the milling standard 
views, where the Z axis is vertical in the graphics window. For 
example, the top view displays the XY plane. 

Alternatively, use the new View > View Mode menu options. 
 

Turning 
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Creating turning Workplanes 
Create a turning Workplane where the Z axis is the rotational axis of 
the part. 

 
To create a turning Workplane: 

1 Click the Turning view  button on the Viewing toolbar to enter 
the turning view mode. 

2 In the Information toolbar, select Use the XY face of the workplane 

. 

This sets the Principal editing plane to be looking down the Z 
axis. 

3 Use the new Create Workplane from Revolved Surface mode: 

 In the Explorer, right-click Workplanes and select Create and 
Orientate Workplane > Workplane from Revolved Surface. 

 In the Information toolbar, click  Workplane from revolved 
surface. 

The Create Workplane from Revolved Surface mode-toolbar is 
displayed. 
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4 Select a rotated surface in the graphics window to locate the 
Workplane origin at its centre. 

 

5 Select the Z axis direction  in the graphics window. 

The Create Workplane from Revolved Surface mode-toolbar is 
closed and the workplane is created. 

 

Creating curves for turning 
You can draw curves to program the turning part, or you can 
extract them from the model. 

 
To create the curves required for turning: 

1 Create a Pattern curve to define the shape of the block. 

This is not required for using a simple cylindrical block. 

2 Create Pattern curves to define the shape of the turning features. 

For example, you can create one curve for outer profiling and 
one for interior boring. You do not need separate curves for 
rough and finish operations. 
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If you are using a model, you can extract the feature curves from 
the model. 

 
To extract a profile curve from a model: 

a In the Explorer, right-click Patterns and select Curve Editor. 

b In the Curve Editor mode-toolbar, click the new Create spun 

profile  button from the Curves pull-down menu. 

c The Spun Profile dialog is displayed. 

 
d Select an option from the Axis of rotation list to specify which 

axis of the active workplane to revolve around. 

e To change the position of the rotation origin, click Switch to 

position mode  in the Origin area. 

f Enter the coordinates of the rotational axis origin, or select it 
in the graphics window. 

g Under Surface, click Surface selection mode  . 

h Select surfaces in the graphics window from which you want 
to create curves, or select nothing to use all available 
surfaces. 

Move your cursor over the  icon to display information 
about which surfaces are selected. 
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i Click Create to create the curve and close the dialog. 

If this does not work correctly, ensure the correct principal 
editing plane is selected. 

 

Defining the block for turning 
Set up the block so it is rotationally symmetrical about the Z axis. 
You can define the block by entering the dimensions directly, by 
rotating a curve about the Z axis, or by calculating it from a model. 

 
There are new and updated options in the Block dialog. 

 
To define a cylindrical block by entering the dimensions: 

1 Under Defined by, select Cylinder. 

2 Ensure the Coordinate System is selected as the centre of rotation 
of the block. 

3 Enter the Min, Max, and Diameter values to define the outer size 
of the cylinder. 

4 Enter the new Inner Diameter value to define the block as a 
hollow tube. 
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To define the block by rotating a curve about the Z axis: 

1 Activate the curve you want to rotate to form the block. 

2 Under Defined by, select the new Spun Pattern option. 

3 Ensure the Coordinate System is selected as the centre of rotation 
of the block. 

  

To calculate a cylindrical block from the model size: 

1 Under Defined by, select Cylinder. 

2 Ensure the Coordinate System is selected as the centre of rotation 
of the block. 

3 Enter an Expansion to leave additional material around the 
model. 

4 In the Type list select Model. 

5 Click Calculate. 

 

There are new Sector options that you can use for sector spun 
parts. 

 
 Azimuth start — Enter a value to specify the start of the azimuth 

angle range. 

 Azimuth end — Enter a value to specify the end of the azimuth 
angle range. 

 Range — Enter a value to specify the size of the azimuth angle 
range. 

There are new and updated options in the Block dialog, under 
Defined by: 

 Cylinder — This option now includes an internal diameter 
component (Inner Diameter). 

 Cylinder Sector — Create the block as a Cylinder but with azimuth 
angles, enabling you to create a sector of a cylinder. 
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 Spun Pattern — Create the block by rotating a pattern about the 
Z axis of the selected coordinate system. This option requires a 
pattern in the XZ plane that does not self-intersect and does not 
cross the X axis. You can create a spun pattern using the new 
Create spun profile option in the curve editor. 

 Spun Pattern Sector — Create the block as a Spun Pattern but with 
azimuth angles, enabling you to create a sector of a cylinder. 

 

Creating turning features 
Create turning features from curves to define the machining limits. 
Features are required to create turning toolpaths. 

 
To create a turning feature: 

1 In the Explorer, right-click Feature Groups and select Feature 
Editor. 

A feature group is created and the Feature Editor mode-toolbar is 
displayed. 

2 Select one of the new turning feature types: 

  Create profile  

  Create a freeform groove  

  Create a parametric groove  

  Create turning face feature  

  Create bore feature  

The Create Features dialog is displayed, depending on the feature 
type. 
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For example, selecting Create profile displays the Create Turning 
Profile Features dialog. 

 
3 Enter a Name for the feature. 

4 Select a curve in the graphics window. 

This curve must be an open curve in the XZ plane that does not 
cross the Z axis. 

The dialog is updated with information about the selected curve. 

5 Click Accept to create the feature and close the dialog. 

6 Click Accept changes  on the Feature Editor mode-toolbar to 
save the created feature. 
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Creating turning tools 
There are new tool categories for turning tools. 

 
Select one of the new options on the Tool toolbar to display the Tool 
dialog. 

  Create a profiling turning tool 

  Create a grooving turning tool 

Alternatively, right-click Tools in the explorer and select one of the 
options under Create tool > Turning. 

Use the Tool dialog to specify the tool properties. For example, for 
an outer profiling tool: 
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 Use the Insert tab to specify the shape and size of the cutting 
insert. 
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 Use the Holder tab to specify the shape, size and orientation of 
the tool holder. Alternatively, you can import a tool holder from a 
model. 
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 Use the Control points tab to specify the tool program point and 
gauge point relative to the insert tip radius centre. 

 
 Program point — Select this option to manually specify the 

point position of the insert that is programmed. If this option 
is deselected the program point is calculated automatically 
from the tool geometry. 

 Gauge point — Select this option to manually specify the 
position where the tool holder attaches to the machine tool 
with respect to the insert tip originw . If this option is 
deselected, the gauge point is calculated automatically from 
the tool geometry. 

Saving turning tools 

You cannot add turning tools to the tool library, but you can save 
them as a template to import them into another document. 
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Creating turning toolpaths 
There are new strategies that you can use to create turning 
toolpaths. 

 
To create a turning toolpath: 

1 In the Main toolbar, click Toolpath strategies , or right-click 
Toolpaths in the Explorer and select Create toolpath. 

2 Select the new Turning page in the Strategy Selector dialog. 

 
3 Select a new turning strategy and click OK to display the 

strategy dialog. 



 

Autodesk PowerMill 2017  Turning • 103  

For example, selecting Turn Rouging displays the Turn roughing 
page of the Turn Roughing strategy dialog. 

 
4 On the Features page, select the Feature group that contains the 

feature you want to machine. 

5 To select only one feature from a feature group, select Specific 
features, select a feature in the graphics window, and click Select 

features . 

Move your cursor over the  icon to display information about 
which features are selected. 

6 Click Calculate to calculate the toolpath. 

7 Click OK to close the dialog. 
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Simulating turning toolpaths 
Simulate toolpaths to check for collisions and see the result. 

 
To simulate turning toolpaths: 

1 In the Explorer, right-click a calculated toolpath or NC program 
and select Simulate from Start. 

2 If you want to view the stock simulation, click ViewMill 

on/suspend  on the ViewMill toolbar to enable ViewMill. 

 You can simulate turning toolpaths without ViewMill. 

3 In the Simulation toolbar, use the Speed control  to 
adjust the speed of the simulation. 

4 Click Play  to start the simulation. 

 Click Go to End  to quickly see the end result. Any 
collisions found are listed in the Machine Tool Simulation 
Issues dialog. 

5 When finished click Exit  to end the simulation. 
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You can simulate internal boring operations by using the View > 
dynamic sectioning option. 
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PowerMill 2017 contains the following changes and improvements to 
the generation of toolpaths: 

 Automatic tool axis limits (see page 107) — You can automatically 
calculate the tool axis limits for a toolpath, using the machine 
tool information. 

 Toolpath connections (see page 108) — You can quickly and 
easily define toolpath connections, rapid move clearances, and 
tool safe areas using the new Toolpath connections dialog. 

 Area clearance offset changes (see page 121) — There are 
modifications to Offset all and Offset model area-clearance 
strategies that reduce the number of small moves required to 
remove upstands. 

 Rib machining enhancements (see page 121) — You can now 
generate rib machining toolpaths that cut down the centreline of 
a rib and along its walls. 

 External thread milling (see page 122) — There is a new Feature 
external thread milling strategy. You can now create toolpaths 
with multiple start points. 

 Finishing strategies enhancements (see page 123) — There are 
small enhancements to the 3D Offset Finishing and Steep and 
Shallow Finishing strategies. 

Generating toolpaths 
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Automatic tool axis limits 
You can now automatically calculate the tool axis limits for a 
toolpath, using the machine tool information. 

To enable this functionality there are enhancements to the Tool axis 
limits strategy page: 

 
Use machine tool when possible — Deselect this option to manually 
calculate the tool axis limits. This option is selected by default. 

Orientation — Select one of the following options from the list to 
define the reference frame for the tool axis limits. 

 Rotary axis configuration — Select this option to limit the tool 
axes with respect to the machine tool rotary axes. 

 Manual — Select this option to limit the tool axes with respect to 
a selected workplane. 

A-axis limit — Select this option to apply limits to the machine tool's 
first rotational axis. Enter Min and Max values to define the limits. 

B-axis limit — Select this option to apply limits to the machine tool's 
second rotational axis. Enter Min and Max values to define the limits. 
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 The A-axis limit and B-axis limit fields are named after the 
rotary axis address of the machine tool. For example if your 
machine tool has A and C rotary axes, the dialog displays A-
axis limit and C-axis limit. The rotational axes must be 
orthogonal. 

Copy from machine tool — Click this button to automatically enter 
the minimum and maximum values of the tool axis limits using the 
machine tool data. 

 

Toolpath connections 
There are enhancements to the user interface and workflow 
associated with the generation of toolpaths that enables you to 
quickly and easily define toolpath connections, rapid move 
clearances, and tool safe areas. 

To support these improvements the following dialogs have been 
removed and had their functionality consolidated into the new 
Toolpath connections dialog (see page 109). 

 Rapid Move Heights. 

 Start and End Point. 

 Leads and Links. 

Additionally the Strategy dialog is updated with new pages reflecting 
the new tabs on the Toolpath connections dialog. 
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Toolpath connections dialog 
Use the tabs on the Toolpath connections dialog to control the 
different properties of the toolpath connections. 
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Safe area — Use the options on this tab to define the size and 
shape of the safe area in which the tool can move at a rapid rate. 

Moves and clearances — Use the options on this tab to define the 
limits of rapid moves and clearances. 

Start and end point — Use the options on this tab to define the 
position and orientation of the start and end points of the 
toolpath. 

Lead ins — Use the options on this tab to define the tool's motion 
before a cutting move. 

Lead outs — Use the options on this tab to define the tool's 
motion after a cutting move. 

Links — Use the options on this tab to define the link moves 
between cutting moves in a toolpath. 

Point distribution — Use the options on this tab to define the 
distribution of points along the leads and links in a toolpath. 

 

Improvements to safe areas 
There are several changes across PowerMill in version 2017 that 
make it easier to define and use the safe areas with respect to the 
rapid moves in links and toolpath connections. 

Using the options on the Safe area tab you can now specify: 

 A length for cylindrical safe areas and whether a tool can move 
over the end faces of the finite cylinder (see page 111). 

 Which sides of a box shaped safe area the tool is free to move 
over during rapid moves (see page 113). 

 The reference object with respect to which the safe area 
dimensions are calculated (see page 115). 

Using the options on the Moves and clearances tab you can now 
specify: 

 The orientation of the skim plane used in planar skim links (see 
page 116). 

 If you want to use planar skim moves for cylindrical and 
spherical safe areas. (see page 116) 

There are two new options on the Start and end point tab: 
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 Incremental plunge — Select to specify whether the plunge move 
at the start of a toolpath is made at an incremental distance 
relative to the target point. You can define the incremental 
plunge distance on the Moves and clearances tab. 

 Direct move — Select to specify whether an absolute move from a 
start point or to an end point is made directly, avoiding the safe 
area if possible. 

 

Changes to cylindrical safe areas 
To specify the length of a cylindrical safe area and include end faces 
for the tool to move over: 

1 Click  on the Main toolbar to display the Safe area tab on the 
Toolpath connections dialog. 

 
2 Select Cylinder from the Type list. 
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The dialog is updated to display the options for a cylindrical safe 
area: 

 
3 Select Finite length and enter a value in the Length field to specify 

the length of the cylindrical safe area. 

4 Select or deselect the Minimum and Maximum options to specify 
which faces are included in the safe area: 

 Minimum — Allow rapid moves to cross the start face of the 
cylinder, defined with respect to the axial direction. 

 Maximum — Allow rapid moves the cross the end face of the 
cylinder, defined with respect to the axial direction. 

5 Click Apply safe area to save your changes and calculate the safe 
area and any moves defined from it. 
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Changes to box safe areas 
To specify which sides of a box shaped safe area the tool is free to 
move over 

1 Click  on the Main toolbar to display the Safe area tab on the 
Toolpath connections dialog. 

 
2 Select Box from the Type list. 
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The dialog is updated to display the options for a box safe area: 

 
3 Toggle the options in the Included faces area to specify the sides 

of the box over which rapid moves are allowed. By default all 
faces are select except for the bottom face (-Z). 

 Minimum — Allow rapid moves to cross the face that lies in the 
negative direction perpendicular to the selected axis. 

 Maximum — Allow rapid moves to cross the face that lies in 
the positive direction perpendicular to the selected axis. 

4 Click Apply safe area to save your changes and calculate the safe 
area and any moves defined from it. 
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Changes to safe area dimensions 
To specify what reference object the safe area dimensions are 
calculated with respect to: 

1 Click  on the Main toolbar to display the Safe area tab on the 
Toolpath connections dialog. 

 
2 Select a reference object from the Measured from list: 

 Block and Model — The safe area is defined with respect to the 
box or cylindrical limits of the block and model combined. The 
cylindrical limits are used if the block is cylindrical and 
encloses the box limits of the model. 

 Block — The safe area is defined with respect to the box or 
cylindrical limits of the block. 

 Model — The safe area is defined with respect to the box 
limits of the model. 
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 Machine tool — The safe area is defined to lie within the linear 
travel limits of a specified machine tool. The tool axis is 
assumed to be aligned with the Z-axis of the Model location 
workplane. 

If you select Machine Tool the area updates with new options: 

 
3 Select a machine tool from the Machine tool list. 

4 Select a workplane from the Model location list. 

5 Click Apply safe area to save your changes and calculate the safe 
area and any moves defined from it. 

 

Changes to planar skim moves 
You can now manually specify the orientation of the skim plane 
when making planar skim links. This is useful if you want to create 
skim links that are more suitable or efficient. 

To specify the orientation of the skim plane: 

1 Click  on the Main toolbar to display the Safe area tab on the 
Toolpath connections dialog. 

2 Click the Moves and Clearances tab. 

3 In the Planar skim moves area select an orientation from the 
Plane list: 

 Automatic — The skim plane is normal to the Z direction of the 
toolpath. 

 Interpolated — The skim plane is normal to the vector halfway 
between the directions of the retract move and the reverse of 
the approach direction. 

 Safe area — The skim plane is parallel to the safe area. This 
option is only available for toolpaths with a planar safe area. 

 Workplane Z — The skim plane is normal to the Z direction of 
an existing workplane, selected from the Workplane field. 

4 Click Apply rapid moves to save your changes and calculate the 
first approach, final retract and all links that have rapid moves 
with respect to the safe area and the new rapid move settings. 
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You can now use planar skim moves with non-planar safe areas. 

To use planar skim moves with a non-planar safe area: 

1 Click  on the Main toolbar to display the Safe area tab on the 
Toolpath connections dialog. 

2 Select a non-planar safe area from the Type list. For example, 
Cylinder. 

3 Click the Moves and Clearances tab. 

4 In the Planar skim moves area select Use with a non-planar safe 
area. 

5 Select an orientation from the Plane list. 

6 Click Apply rapid moves to save your changes and calculate the 
first approach, final retract and all links that have rapid moves 
with respect to the safe area and the new rapid move settings. 

 

Improvements to links 
There are changes to the interface and workflow with respect to 
specifying how to make the link moves between the cutting moves 
in a toolpath. In previous versions of PowerMill you would specify a 
threshold value to determine whether a link was long or short, with 
each having their own properties 

In PowerMill 2017 links are specified as a first choice link, second 
choice link, and a default link. You can apply constraints to the links 
to define the circumstances in which they are used. If the constraint 
criteria of the first choice link are not satisfied, or if they are 
satisfied but could not be applied, for example, it is unsafe, 
PowerMill tries to apply the second choice link. If the constraint 
criteria of the second choice link are not satisfied PowerMill applies 
the default link. 

You can choose to create links with no constraints.In this instance, 
if it is possible, PowerMill applies the chosen link type to appropriate 
parts of the toolpath. If Gouge check is selected the 1st choice and 
2nd choice links are only created if they are safe, otherwise the 
Default link is used. 

If you choose to create links with no constraints and Gouge check is 
not selected, then the 1st choice link will be used in all cases, 
regardless of safety. 
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Use the Links tab on the Toolpath connections dialog to specify your 
link options: 

 
1st choice — Select the type of link moves from the list for your first 
choice. PowerMill applies this link where its constraint criteria are 
met. 

2nd choice — Select the type of link moves from the list for your 
second choice. PowerMill applies this link if the constraint criteria for 
the 1st choice links are not met. 

Default — Select the type of link moves from the list for you default 
choice. PowerMill applies this link if the constraint criteria for both 
the 1st choice and 2nd choice links are not met, or if they gouge. 

Motion — Select an option from the list to specify how the tool axis 
changes as it moves across the link. These options are only 
available whenever the tool axis may change along the toolpath. 

Simultaneous — The tool axis is free to move along the link. 

Move then rotate — The behaviour is dependent on the path: 
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 Rapid surface paths — The tool moves to the position above its 
target within the rapid surface, then changes the tool axis when 
it leaves the rapid surface. 

 Direct paths — The tool axis is fixed until it reaches the end of 
the link. 

Rotate then move — The behaviour is dependent on the path: 

 Rapid surface paths — The tool axis changes when the tool 
reaches the rapid surface, it then moves into the next position. 

 Direct paths — The tool axis changes at the start of the link. 

Rapid surface normal — The tool axis is fixed perpendicular to the 
rapid surface as it moves across it. This option is only available for 
toolpaths that travel through the rapid surface. 

Reset machine tool — The tool axis is aligned to the machine tool's 
inital orientation across the course of the link. 

Rotation point — The tool axis is fixed as it moves through the safe 
area to the origin of the specified workplane. The tool axis then 
rotates and moves to the next link. 

Apply constraints — Select this option to apply constraints to your 
links and then select a constraint from the list. Selecting a 
constraint from the list creates an additional field to apply further 
constraints. 1st choice and 2nd choice links have a maximum of 4 
constraints. If more than one constraint is selected they must all be 
satisfied for a link to be applied. 

 Distance — Constrain the link by its distance spanned. 

 Surface slope — Constrain the link by the slope angle of the 
surface at either end of the link. 

 Angular change — Constrain the link by the angular change of the 
tool axis. 

 Azimuth — Constrain the link by the change in the azimuth angle 
of the tool axis. 

 Elevation — Constrain the link by the change in the elevation 
angle of the tool axis. 

 — Select an option from the list to define the constraint limit: 
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 — The constraint is satisfied if the parameter is less than the 
specified value. 

 — The constraint is satisfied if the parameter is greater than 
the specified value. 

Rotary axis configuration — Displays the current rotary axis 
configuration. This is only visible if you select constraints of Azimuth 
and Elevation. 

Gouge check — Select this option to automatically check links for 
gouges. If this option is selected and a 1st choice or 2nd choice link 
gouges the part then the Default link is used instead. 

 

Links example 
The following example demonstrates creating arc links that are 
restricted to shallow regions of the model. 

1 Click  on the Main toolbar to display the Lead ins tab of the 
Toolpath connections dialog. 

2 Click the Links tab. 

3 Select Circular arc from the 1st choice list. 

4 Select Surface slope from the constraint list. 

5 Select  from the list. 

6 Enter a value of 20. 

7 Click Apply links. 

In this example circular arc links are created in areas where the 
surface slope at either end of the link does not reach a value 
greater than 20 degrees. Since no constraints were applied to the 
2nd choice link, any links that are created in areas where the 
surface slope is greater than 20 degrees are created as 2nd choice 
links, unless they gouge, in which case they are created as Default 
links. 
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Area clearance offset changes 
There are modifications to Offset all and Offset model area-clearance 
strategies. When you specify a stepover distance greater than the 
tool radius PowerMill now incrementally reduces the toolpath offset 
to minimise the number of small movements to remove upstands 
. Additionally, the connections between toolpaths have been 
optimised . These changes reduce the consumption of tool inserts 
at the cost of marginally increased cutting times. 
PowerMill 2016 

 

PowerMill 2017 

 
 

 

Rib machining enhancements 
There are enhancements to rib machining: 

 There is a new Centre and walls option in the Style list on the Rib 
machining page of the Strategy dialog. 

Select this option to create a toolpath that machines down the 
centreline of the channel and then machines down each side of 
channel. 

 
 PowerMill now correctly handles intersecting ribs at different 

heights for rib machining toolpaths. 
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External thread milling 
There is a new Feature External Thread Milling strategy on the Feature 
Machining page of the Strategy Selector dialog which replaces the old 
External thread milling strategy on the Drilling page. 

 
You can now create toolpaths with intertwined threads by specifying 
the Number of start positions. Enter a value to create identical 
toolpaths that are rotated about the tool axis and spaced 
equidistantly. 
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Toolpath with one start 
position 

 

Toolpath with three start 
positions 

 
 

 

Finishing strategies enhancements 
3D offset finishing 

You can now specify which direction the toolpath offset is calculated 
from. 

 
From the Offset direction list, select: 

 Outside In — Calculates the toolpath offset from the outside in. 

 Inside Out — Calcualtes the toolpath offset from the inside out. 

  

Steep and shallow finishing 

You can now add a perpendicular pass to steep and shallow finishing 
strategies that use a raster style. The Raster sub-page of the Steep 
and shallow finishing page contains the following new options: 

 Perpendicular pass — Select to define a second raster pass 
perpendicular to the first one. 
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 Shallow angle — Enter an angle to specify that the raster pass 
machines only the areas of the model that are steeper than this 
angle. 

 Optimise parallel pass — If a raster toolpath is created with a 
parallel and perpendicular pass, and with a shallow angle greater 
than 0_, select this option to trim the parallel pass so it does not 
machine the areas that the perpendicular pass machines. 
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PowerMill 2017 contains the following changes and improvements to 
the simulation of toolpaths: 

 Simulation pausing (see page 126) — You can now control how 
often and on what types of issues simulation stops. 

 Simulation playback (see page 128) — There are new controls on 
the Simulation toolbar. 

 Simulation toolbar — The Simulation issues  button is now on 

the Simulation toolbar. There is a new Collision checking  
button on the Simulation toolbar. Toggle this button to turn 
collision checking on or off. 

Simulating toolpaths 
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Simulation pausing 
There are enhancements to the pausing of simulations. 

There are new options to control: 

 what type of issues simulations stop on. 

 how often simulations stop on issues. 

To support these improvements there are changes to the Simulation 
Issues dialog: 

 

 Enter values for the following: 

 Holder clearance — Specify the minimum distance, between the 
tool holder and the model or machine tool, before a clearance 
issue is generated. 

 Shank clearance — Specify the minimum distance, between the 
tool shank and the model or machine tool, before a clearance 
issue is generated. 

 Check for reconfiguration moves — Select this option to include 
reconfiguration moves as an issue to stop simulation. If this option 
is unselected then reconfiguration moves do not cause the 
simulation to be paused and are not added to the issues list. This 
option is selected by default. 

 — Select an option from the list to specify how often the 
simulation is paused when encountering issues: 

 Always pause on issues — Simulation stops for all issues 
encountered. 



 

Autodesk PowerMill 2017  Simulating toolpaths • 127  

 Pause on the first issue of each type — Simulation stops on the 
first issue of any type encountered. If you resume simulation it 
will not stop again on an issue of the same type. This option is 
selected by default. 

 Never pause on issues — Simulation does not stop for any issues 
encountered. Encountered issues are still logged in the Issues 
found list. 
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Simulation playback 
There are enhancements to the simulation playback controls and 
functionality. To support these improvements there are changes to 
the Simulation toolbar. 

 

Select an option from the new Item flyout  to specify how the step 
and play buttons behave: 

  — Play or step to the next tenth of a point. 

  — Play or step to the next point. 

  — Play or step five points. 

  — Play or step fifty points. 

  — Play or step to the next component. Components 
are specified as: segments, leads, links, approaches, retracts, 
and connections. 

  — Play or step to the next NC item. 

Select an option from the new Play to flyout  to specify how far 
the simulation plays: 

  Play — Select this option to play the simulation to the end. 

  Play item— Select this option to play the simulation to the 
end of the current item. The item is defined by your selection 
from the Item flyout. 

To change the simulation mode select Tools > Options and then 
select Simulation > Simulation Mode. The following options are 
available: 

 Feed rate — Select this option to simulate at a speed relative to 
the feed rate. 

 Points — Select this option to simulate at a speed relative to a 
constant number of toolpath points per second. 

 Distance — Select this option to simulate at a constant speed 
relative to the distance moved by the tool. 
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PowerMill 2017 contains the following general improvements: 

 ViewCube (see page 129) — Use the new ViewCube to 
interactively orientate the contents of the graphics window. 

 Live text creation (see page 131) — You can now create text as 
wireframe, for engraving or leaving comments in a project. 

 Autodesk A360 (see page 134) — The Tools options includes an 
Autodesk A360 option. 

 Watertight stock models — You can now export watertight stock 
models as .stl or .dmt files. 

 Save strategy parameters — The parameters you can individually 
select to save with a strategy are updated to reflect the toolpath 
connection changes. 

 

ViewCube 
The ViewCube is a new feature in PowerMill, which enables you to 
change and identify the viewpoint of the Graphics window. By 
clicking the ViewCube’s corners, faces, edges, and icons, you can 
use it to directly manipulate the view in the Graphics window. In 
addition, when you re-orient the view using a cube option, toolbar 
button, or keyboard shortcut, the ViewCube automatically reflects 
the new viewpoint.  

 
The ViewCube is displayed in the upper-right corner of the Graphics 
window. Click and drag the cube to re-orient the view in any 
direction. Alternatively, click:  

 a face to show it as an orthogonal view.  

General enhancements 
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 an edge to show the adjacent faces. 

 a corner to show the three adjacent faces.  

In addition, when you move the cursor near the cube, the Home  
icon is displayed. Click the icon to show the Home view.  

Manipulating orthogonal views 

When you select a single-face view and move the cursor near the 
cube, control icons are displayed: 

 
Click: 

     to show the view of an adjacent face. 

  to rotate the view clockwise through 90 degrees.  

  to rotate the view counter-clockwise through 90 degrees.  

Configuring the ViewCube 

To control the behaviour and appearance of the ViewCube, right-
click the cube and choose a menu option. Select: 

 Set current view as home and keep scale to save the current 
orientation and magnification of the model as the Home view.  

 Set current view as home and scale to fit to save the current 
orientation of the model as the Home view, and scale it to fit the 
Graphics window. 

 Options to display and change the settings of the ViewCube. 

Setting ViewCube options 

To modify the behaviour and appearance of the ViewCube, use the 
following options: 

 Show the ViewCube — Select this check box to show the 
ViewCube in the Graphics window. Deselect the check box to 
hide it.  

 ViewCube size — Select an option from the list to choose the size 
of the ViewCube in the Graphics window. Alternatively, select 
Automatic to resize the cube when you resize the Graphics 
window.  

 Keep model upright — Select this check box to prevent the view 
from being inverted. If you click an edge, corner, or face that 
would leave the view upside down, the Graphics window switches 
to the selected view and then rotates to leave the view upright. 
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Live text creation 
You can now create text as wireframe, for engraving or leaving 
comments in a project, using the new text creation tools on the 
Curve Editor mode-toolbar. 

There is a new flyout on the Curve Editor mode-toolbar with the 
following buttons: 

 

  Horizontal text — Click to create text in the positive horizontal 
direction of the principal working plane. 

 

  Vertical text — Click to create text in the negative vertical 
direction of the principal working plane. 

 

  Text on a curve — Click to create text along a curve. 
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  Text on a circle — Click to create text on a circle. 

 
 

Create horizontal text example 
To create horizontal text: 

1 Right-click Patterns in the explorer and select Curve Editor... from 
the Patterns context menu. 

The Curve Editor mode-toolbar is displayed. 

2 Click the Horizontal text  button from the text creation flyout. 

The Text toolbar is displayed (see page 133). 

 
3 Click in the graphics window to set the origin of the text. 

4 Type your text. 

 

 To change the colour of the text to be visible on your 
background select Tools > Customise Colours and choose 
Curve Editor > Edit Text. 

5 Use the options on the Text toolbar to modify your text. 



 

Autodesk PowerMill 2017  General enhancements • 133  

6 Click Accept changes  on the Curve Editor mode-toolbar to 
save the created text as wireframe. 

 
 

Text toolbar 
Use the options on the text toolbar to modify your text: 

 

 — Select an option from the list to specify the text font. 

 Single line fonts are available when PowerMill Modelling is 
installed. 

 — Enter a value to specify the size of the text. 

 — Click to apply bold typeface to the text. 

 — Click to apply italic typeface to the text. 

 — Click to apply an underline to the text. 

 — Select an option from the list to specify the text 
justification. 

 — Select an option from the list to specify the position of the 
text with respect to its origin. This option is only available for 
Horizontal and Vertical text. 

 — Select an option from the list to specify the position of the 
text with respect to the curve. This option is only available for Text 
on a curve and Text on a circle. 

 — Click to flip the text horizontally. 

 — Click the flip the text vertically. 

 — Enter a value to specify the character spacing. 
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 — Enter a value to specify the line spacing. This option is 
only available for Horizontal and Vertical text. 

 — Enter an Alt code to insert special characters. 

 — Click to select a curve in the graphics window. This button is 
only available for Text on a curve. 

Radius — Enter a value to specify the radius of the circle. This 
option is only available for Text on a circle. 

 — Click to convert horizontal text to vertical text. This option is 
only available for Horizontal and Vertical text. 

 — Click to convert vertical text to horizontal text. This option is 
only available for Horizontal and Vertical text. 

 — Click to graphically move the text origin in the graphics 
window. 

 

Autodesk A360 
The Tools menu includes an Autodesk A360 option, which displays 
the Autodesk A360 website. Autodesk A360 is a cloud-based 
resource, which enables you to interact with other people and share 
information about projects. For example, you can use it to upload 
CAD model files so others can view your ideas and provide 
feedback. 

 
The keyboard shortcut for this menu option is Alt+T+A. 
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